To ensure that you are using the documentation that corresponds to the software you are licensed to use, compare this version number with the software version shown in “About MicroStrategy...” in the Help menu of your software.

Document number: 09570921
Copyright © 2011 by MicroStrategy Incorporated. All rights reserved.

If you have not executed a written or electronic agreement with MicroStrategy or any authorized MicroStrategy distributor, the following terms apply:

This software and documentation are the proprietary and confidential information of MicroStrategy Incorporated and may not be provided to any other person. Copyright © 2001-2011 by MicroStrategy Incorporated. All rights reserved.

This software and documentation are provided "AS IS" AND WITHOUT EXPRESS OR LIMITED WARRANTY OF ANY KIND BY EITHER MICROSTRATEGY INCORPORATED OR ANYONE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, GOOD TITLE AND NONINFRINGEMENT, QUALITY OR ACCURACY. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE AND DOCUMENTATION IS WITH YOU. SHOULD THE SOFTWARE OR DOCUMENTATION PROVE DEFECTIVE, YOU (AND NOT MICROSTRATEGY, INC. OR ANYONE ELSE WHO HAS BEEN INVOLVED WITH THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE OR DOCUMENTATION) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

Some states do not allow the exclusion of implied warranties, so the above limitation may not apply to you.

In no event will MicroStrategy, Inc. or any other person involved with the creation, production, or distribution of the Software be liable to you on account of any claim for damage, including any lost profits, lost savings, or other special, incidental, consequential, or exemplary damages, including but not limited to any damages assessed against or paid by you to any third party, arising from the use, inability to use, quality, or performance of such Software and Documentation, even if MicroStrategy, Inc. or any such other person or entity has been advised of the possibility of such damages, or for the claim by any other party. In no event shall MicroStrategy, Inc. or any other person involved in the creation, production, or distribution of the Software be liable for any claim by you or any other party for damages arising from the use, inability to use, quality, or performance of such Software and Documentation, based upon principles of contract warranty, negligence, strict liability for the negligence of indemnity or contribution, the failure of any remedy to achieve its essential purpose, or otherwise. The entire liability of MicroStrategy, Inc. and your exclusive remedy shall not exceed, at the option of MicroStrategy, Inc., either a full refund of the price paid, or replacement of the Software. No oral or written information given out expands the liability of MicroStrategy, Inc. beyond that specified in the above limitation of liability. Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so the above limitation may not apply to you.

The information contained in this manual (the Documentation) and the Software are copyrighted and all rights are reserved by MicroStrategy, Inc. MicroStrategy, Inc. reserves the right to make periodic modifications to the Software or the Documentation without obligation to notify any person or entity of such revision. Copying, duplicating, selling, or otherwise distributing any part of the Software or Documentation without prior written consent of an authorized representative of MicroStrategy, Inc. are prohibited. U. S. Government Restricted Rights. It is acknowledged that the Software and Documentation were developed at private expense, that no part is public domain, and that the Software and Documentation are Commercial Computer Software provided with RESTRICTED RIGHTS under Federal Acquisition Regulations and agency supplements to them. Use, duplication, or disclosure by the U.S. Government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFAR 252.227-7013 et. seq. or subparagraphs (c)(1) and (2) of the Commercial Computer Software—Restricted Rights at FAR 52.227-19, as applicable. Contractor is MicroStrategy, Inc., 1850 Towers Crescent Plaza, Vienna, VA 22182. Rights are reserved under copyright laws of the United States with respect to all portions of the Software.


All other company and product names may be trademarks of the respective companies with which they are associated. Specifications subject to change without notice. MicroStrategy is not responsible for errors or omissions. MicroStrategy makes no warranties or commitments concerning the availability of future products or versions that may be planned or under development.

Patent Information

This product is patented. One or more of the following patents may apply to the product sold herein: U.S. Patent Nos. 6,154,766, 6,173,310, 6,260,050, 6,263,051, 6,269,393, 6,279,033, 6,567,796, 6,587,547, 6,606,596, 6,658,093, 6,658,432, 6,671,715, 6,691,100, 6,694,316, 6,697,808, 6,704,723, 6,741,980, 6,765,997, 6,788,788, 6,772,137, 6,788,768, 6,798,867, 6,801,910, 6,820,073, 6,836,537, 6,850,603, 6,859,798, 6,873,693, 6,885,734, 6,940,953, 6,964,012, 6,977,992, 6,996,568, 6,996,569, 7,003,512, 7,010,518, 7,016,480, 7,020,251, 7,039,165, 7,082,422, 7,113,993, 7,127,403, 7,174,349, 7,181,417, 7,194,457, 7,197,461, 7,228,303, 7,260,577, 7,286,181, 7,272,212, 7,302,639, 7,324,942, 7,330,847, 7,340,040, 7,356,758, 7,356,840, 7,415,438, 7,428,302, 7,430,562, 7,440,896, 7,446,780, 7,509,671, 7,516,181, 7,559,048, 7,574,376, 7,617,201, 7,725,811, 7,801,967, 7,836,178, 7,861,161, 7,861,253, 7,881,443, 7,925,616, and 7,945,584. Other patent applications are pending.

Various MicroStrategy products contain the copyrighted technology of third parties. This product may contain one or more of the following copyrighted technologies:

Graph Generation Engine Copyright © 1998-2011. Three D Graphics, Inc. All rights reserved.
Actuate® Formula One. Copyright © 1993-2011 Actuate Corporation. All rights reserved.
XML parser Copyright © 2003-2011 Microsoft Corporation. All rights reserved.
Xalan XSLT processor. Copyright © 1998-2011, The Apache Software Foundation. All rights reserved.
Xerces XML parser. Copyright © 1999-2011, The Apache Software Foundation. All rights reserved.
FOP XSL formatting objects. Copyright © 2004-2011, The Apache Software Foundation. All rights reserved.
Portions of Intelligence Server memory management Copyright © 1991-2011 Compuware Corporation. All rights reserved.
ASHTHTTPRequest library. Copyright © 2007-2011, All-Seeing Interactive. All rights reserved.

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)
CONTENTS

1. Get Started Now with the MicroStrategy Reporting Suite
   - Upgrading your existing installation ........................................... 1
   - Installation prerequisites .......................................................... 2
     - Understanding the MicroStrategy components ....................... 2
     - Understanding licensing ....................................................... 4
     - Hardware requirements and recommendations ....................... 4
     - Software requirements and recommendations ....................... 5
   - Supporting UNIX and Linux environments ............................... 6
   - Downloading and extracting the MicroStrategy Reporting Suite ........................... 6
   - Installing the MicroStrategy Reporting Suite ........................... 8
   - Configuring the MicroStrategy Reporting Suite ........................ 14

2. Creating a MicroStrategy Project with Your Data
   - Design a project, attributes, facts, and hierarchies .................. 27
   - Design metrics ........................................................................ 49

3. Designing Reports
   - Create a report ....................................................................... 53
   - Create a graph ........................................................................ 56

4. Exploring Data in MicroStrategy Web
   - Go live with MicroStrategy Web .............................................. 61
   - Run reports and explore the data ........................................... 64
   - Visualize the data .................................................................... 70
   - Drill through the data ............................................................. 73
   - Run ad hoc reports .................................................................. 75
5. Additional Security Configurations

<table>
<thead>
<tr>
<th>A. Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requesting or retrieving a license key ........................................ 87</td>
</tr>
<tr>
<td>Returning to the Reporting Suite download page .......................... 88</td>
</tr>
<tr>
<td>Locating the downloaded zip file ................................................ 88</td>
</tr>
<tr>
<td>Installing on a certified operating system ................................. 89</td>
</tr>
<tr>
<td>Installing Microsoft IIS ........................................................... 89</td>
</tr>
<tr>
<td>Resolving a JVM memory-related error .............................. 92</td>
</tr>
<tr>
<td>Resolving error code 0x80070005 .............................................. 92</td>
</tr>
<tr>
<td>Addressing issues with number of CPUs .................................... 92</td>
</tr>
<tr>
<td>Logging in to the Reporting Suite software .............................. 93</td>
</tr>
<tr>
<td>Addressing issues with number of users ................................... 94</td>
</tr>
</tbody>
</table>

Additional Resources ........................................................................ 95

| Online Support, Training, and Videos .............................. 95 |
| Documentation ................................................................. 96 |
| Additional formats ......................................................... 104 |
GET STARTED NOW WITH THE MICROSTRATEGY REPORTING SUITE

Introduction

The steps below show you how to download, install, activate, and configure the MicroStrategy Reporting Suite.

Upgrading your existing installation

If you have already installed and configured your MicroStrategy Reporting Suite and you are upgrading your software, complete only the following steps:

1. Download and extract the new version of the MicroStrategy Reporting Suite. The steps to complete this task are provided in this guide.

2. See the MicroStrategy Upgrade Guide for important pre-installation information and all the steps you need to complete the upgrade process.
Installation prerequisites

Before you install the MicroStrategy Reporting Suite, review the following prerequisites:

- *Understanding the MicroStrategy components, page 2*
- *Understanding licensing, page 4*
- *Hardware requirements and recommendations, page 4*
- *Software requirements and recommendations, page 5*
- *Supporting UNIX and Linux environments, page 6*
- *Downloading and extracting the MicroStrategy Reporting Suite, page 6*

Understanding the MicroStrategy components

The MicroStrategy Reporting Suite includes the MicroStrategy products and components required to provide premium reporting capabilities to quickly develop and deliver operational and analytical reports from your data.

General requirements and information on the installation of the products and components provided with the MicroStrategy Reporting Suite are provided below:

- MicroStrategy Report Services, OLAP Services, and Distribution Services are installed with MicroStrategy Intelligence Server.
- MicroStrategy Office has two components: MicroStrategy Web Services which is installed with MicroStrategy Web Reporter, and the MicroStrategy Office client application which is installed on end user computers running Microsoft Office.

For information on allowing users to install the MicroStrategy Office client application from a network location, refer to *Chapter 1, Planning*

• MicroStrategy Mobile includes:
  ◦ MicroStrategy Mobile Server, which supports the MicroStrategy Mobile client applications for iPhone, iPad, and BlackBerry devices.
  ◦ The BlackBerry client application which can be installed on BlackBerry smartphones.

For information on installing the Mobile client applications on mobile devices, refer to the MicroStrategy Mobile Design and Administration Guide.

• You can install the following sample MicroStrategy projects, which are stored in Microsoft Access databases and can be installed on Windows operating systems:
  ◦ MicroStrategy Tutorial Reporting is a sample MicroStrategy project with a metadata and warehouse, and a set of demonstration applications designed to illustrate the platform's rich functionality. For more information on the Tutorial project and disabling sample users in that project, see Addressing issues with number of users, page 94.
  ◦ MicroStrategy Analytics Modules are a set of packaged analytic components built using the MicroStrategy platform. The modules can be mapped to a different warehouse or used as starter kits to develop custom applications.

• If you plan to install on a UNIX-based platform, you will be installing MicroStrategy Web Reporter and MicroStrategy Intelligence Server on a UNIX-based platform, and you will be installing MicroStrategy Desktop and MicroStrategy Architect on a Windows platform.

• For hardware and software requirements specific to MicroStrategy products and components, refer to the MicroStrategy readme files for the products you plan to install.

• For a more detailed description of the products listed above, refer to Chapter 1, Planning Your Installation of the Installation and Configuration Guide.
Understanding licensing

Licenses for the MicroStrategy Reporting Suite are obtained during the download and installation process, as described in *Installing the MicroStrategy Reporting Suite, page 8*. Prior to requesting a license for the MicroStrategy Reporting Suite, review the following information:

- The MicroStrategy Reporting Suite includes up to 100 named user licenses for MicroStrategy Web Reporter and MicroStrategy Intelligence Server, with a 1-CPU limit for Intelligence Server. For details on CPU usage, see *Addressing issues with number of CPUs, page 92*.
- The Reporting Suite also includes two complimentary named user licenses for MicroStrategy Desktop and MicroStrategy Architect, which let you configure and build your business intelligence project.

Hardware requirements and recommendations

MicroStrategy acknowledges that variables such as processor speed, CPU type, file space, and physical and swap memory are factors that play an important role in making your deployment of MicroStrategy a successful one. The general hardware requirements for the MicroStrategy Reporting Suite are as follows:

- To save the downloaded files and extract the files, your machine needs approximately 4.8 gigabytes (GB) of free hard drive space.
- Your machine needs 4 GB or higher of memory (RAM) to support the MicroStrategy Reporting Suite.
- To install the extracted files and support the use of the Reporting Suite, your machine needs hard drive space that is three times the amount of RAM available. For example, if you are providing the minimum 4 GB of RAM described above, then the machine needs 12 GB of hard drive space.
- Your machine needs a 1.8 gigahertz (GHz) or higher processor to support the MicroStrategy Reporting Suite. For processor chipset support, refer
to the MicroStrategy readmes for operating system certification and support information.

For guidance on processor speed, RAM, and hard disk requirements for specific MicroStrategy products installed on Windows, UNIX, and Linux platforms, refer to the MicroStrategy readme files for the products you plan to install.

Software requirements and recommendations

- You have an available data source that contains the information for your business. This can be a Microsoft Access database, Microsoft Excel spreadsheet, or some other database or data source.

- You have an available data source that can store the MicroStrategy metadata. This can be an empty Microsoft Access database or another database such as PostgreSQL.

- To install MicroStrategy Web, MicroStrategy Web Services, and MicroStrategy Mobile Server, you must have a web server such as Microsoft Internet Information Services (IIS) installed. IIS is installed by default on Windows server operating systems, and is an optional component on other Windows operating systems. For information on installing IIS on your Windows operating system, refer to the third-party Microsoft documentation provided at http://www.iis.net/.

For information on supporting MicroStrategy products with IIS 7.0 and 6.0, see Installing Microsoft IIS, page 89.

For information on supporting other types of web servers, see the Installation and Configuration Guide.

If you are installing MicroStrategy Web and MicroStrategy Mobile Server on a Microsoft Windows XP machine, you cannot deploy both of these products using IIS. You must do one of the following:


- Use a web server other than IIS to deploy at least one of these two MicroStrategy products.

- Installing the MicroStrategy Reporting Suite to replace an existing MicroStrategy configuration will also replace the licensing terms of the existing MicroStrategy software. This includes previous installations of MicroStrategy products including the MicroStrategy Mobile Suite,

In addition, MicroStrategy acknowledges that variables such as operating systems, application servers, web servers, JDKs, database management systems, and other supporting software requirements are factors that play an important role in making your deployment of MicroStrategy a successful one. For guidance on these software requirements, refer to the MicroStrategy readme files for the products you plan to install.

**Supporting UNIX and Linux environments**

If you plan to install on a UNIX-based platform, you will be installing MicroStrategy Web Reporter and MicroStrategy Intelligence Server on a UNIX-based platform, and you will be installing MicroStrategy Desktop and MicroStrategy Architect on a Windows platform.

In addition to this requirement, there are other configurations that allow you to support the MicroStrategy Reporting Suite on UNIX-based platforms. The benefits of these configurations are described briefly below:

- **Recommended system settings for UNIX and Linux**: For UNIX and Linux systems, a number of system settings can affect the performance of MicroStrategy Intelligence Server Universal. These settings do not need to be set prior to a MicroStrategy installation. For more information on these settings and their recommended values, refer to *Chapter 1, Planning Your Installation* of the *Installation and Configuration Guide*.

- **Configuring shared memory resources**: To improve the performance of MicroStrategy Intelligence Server Universal for large scale production applications, Intelligence Server Universal can be configured to use shared memory resources. To support this configuration, you must ensure that your Intelligence Server Universal host machine uses values greater than or equal to the resource limits. For information on defining these resource limits, refer to *Chapter 1, Planning Your Installation* of the *Installation and Configuration Guide*.

**Downloading and extracting the MicroStrategy Reporting Suite**

Before you begin these steps, ensure that you have reviewed the hardware and software requirements listed in *Hardware*.
To download the Reporting Suite

1. Go to www.microstrategy.com/freereportingsoftware/ and click Download Now. To access the MicroStrategy Resource Center site, log in using your existing MicroStrategy account information, or create an account using your corporate email address. The Request License Key page opens.

2. You are asked to select a license key for the user size bundle that you require. The MicroStrategy Reporting Suite is available in three user-size bundles: 25 named users, 50 named users, and 100 named users. All are free. If you later choose to add live support, live support pricing will be based on how many named users are in your bundle. For more information on the MicroStrategy Reporting Suite licenses, see Understanding licensing, page 4.

   Determine the number of named users you need licenses for, and click Request License Key next to your choice of number of named users. The Contract Acceptance page opens.

3. You can provide answers to the optional questions that are displayed. Then read the notice and licensing information, and if you agree to the terms, select the Yes check box beneath the license.

4. Click Submit. The Download Software page opens, and an email is automatically sent to the email address associated with your MicroStrategy account. This email contains the license key to your MicroStrategy Reporting Suite software.

5. On the Download Software page, depending on your machine’s platform and your geographic location (Asia Pacific has a separate set of links), click one of the links to display installation instructions and the link to download your software:

   • Click for Instructions and Download Files for MicroStrategy for Windows

   • Click for Instructions and Download Files for MicroStrategy for UNIX, Linux, Solaris, AIX, and HP-UX.
6 Click **Download Now** to save a compressed file that contains the Reporting Suite installation files. To make this file easier to locate, save it to an empty folder.

7 Extract the files.

Once the files are extracted you can install the MicroStrategy Reporting Suite.

⚠️ If you are upgrading your MicroStrategy Reporting Suite software, see the **MicroStrategy Upgrade Guide** to complete the upgrade process.

For steps, see *Installing the MicroStrategy Reporting Suite, page 8*. You can also review additional documentation resources prior to installing the Reporting Suite. For steps, see *Accessing additional documentation resources prior to installation, page 103*.

# Installing the MicroStrategy Reporting Suite

Before you begin the installation of the MicroStrategy Reporting Suite, review the *Installation prerequisites, page 2*.

The prerequisites listed below are requirements for completing the installation process.

**Prerequisites**

- You have downloaded and extracted the Reporting Suite installation files (see *Understanding the MicroStrategy components, page 2*).

- You have the license key that was emailed to you available during the installation steps.

- Close all other software applications currently running on your computer.

- To install MicroStrategy, you must have the following permissions and privileges:
  - Windows:
    - You must log on to your machine using a domain account with Windows administrative privileges for the domain or target machine.
The user installing MicroStrategy must have write permissions in the installation directory to complete the installation.

UNIX and Linux:

- If you want a non-root user to be the administrator of the server, you must manually change the ownership after running the installation. Intelligence Server operation is dependent on root user privileges and permissions. Therefore, changing the ownership of Intelligence Server to a non-root user is not a certified or recommended practice.

- Only a user with root permissions can register MicroStrategy Intelligence Server as a service. If the Intelligence Server is registered as an application during installation, the root user can register the server as a service after running the installation. For more information on running Intelligence Server as a service, see the MicroStrategy System Administration Guide.

If you do not have the appropriate permissions and privileges, you may see an error code; for details see Resolving error code 0x80070005, page 92.

---

To install the MicroStrategy Reporting Suite

If you are upgrading your existing MicroStrategy Reporting Suite software, see the MicroStrategy Upgrade Guide to complete the upgrade process. Do not continue with the information in this guide.

1 Navigate to the folder in which you extracted the Reporting Suite installation files. If you need to search for this file, it is named as follows:

- MicroStrategyWindows921.zip for Windows
- MicroStrategyLinux921.zip for Linux
- MicroStrategySolaris921.zip for Oracle Solaris
- MicroStrategyAIX921.zip for IBM AIX
- MicroStrategyUX921.zip for HP-UX
To begin the installation process, use one of the following options based on the machine’s operating system and whether the machine has Adobe Flash installed:

- For a Windows machine with Adobe Flash support: Double-click MicroStrategy.exe. An Adobe Flash file opens to help you begin the installation process. Click **Install Software**, and then click **Begin MicroStrategy Platform Installation**.

- For a Windows machine without Adobe Flash support: Open the Installations folder, and double-click setup.exe.

- For a UNIX or Linux machine: Browse to the Installations folder. Depending on your UNIX or Linux environment, browse to one of the following folders:
  - **Solaris**: QueryReportingAnalysis_SunOS
  - **AIX**: QueryReportingAnalysis_AIX
  - **HP-UX**: QueryReportingAnalysis_HP-UX
  - **Linux**: QueryReportingAnalysis_Linux

  Then type one of the following, depending on your operating system:
  - **Solaris**: ./setupsol.bin
  - **AIX**: ./setupAIX.bin
  - **HP-UX**: ./setupHPIA64.bin
  - **Linux**: ./setupLinux.bin

If this is the first time you have installed the MicroStrategy Reporting Suite, you are prompted to choose the language for the wizard. Select the appropriate language from the drop-down list and click **OK**.

The MicroStrategy Installation Wizard opens. Click **Next**.

Guidance on how to proceed with the installation on a Windows platform is provided in the remaining steps below. If you encounter a question or warning message during installation that is not documented in the steps below, contact your system administrator to determine how to proceed with the request, or use any of the resources below:

- For installation on Windows: With the MicroStrategy Installation Wizard open, click **Help** or press **F1** to open the MicroStrategy Installation Wizard Help.
• For installation on UNIX or Linux: Refer to Chapter 3, Installing MicroStrategy on UNIX and Linux of the Installation and Configuration Guide.

• For all platforms, once installation is complete you can access additional documentation and resources to support your use of the MicroStrategy Reporting Suite. See Additional Resources, page 95.

5 Read the information on the Welcome screen and click Next. The License Agreement page opens.

6 Read the license agreement, and accept the agreement by selecting the appropriate option. Click Next.

• If you are prompted to stop Windows services, click Yes to allow the Installation Wizard to stop the Windows services and continue with the Reporting Suite installation.

The Customer Information page opens.

7 Type your user and company information. You must also type your MicroStrategy Reporting Suite license key, which was emailed to you. Click Next.

The Setup Type page opens.

8 Accept all defaults and click Next on each installation page until you reach the Select Features page, as shown below.
9 Accept all defaults to install all products and features provided with the Reporting Suite, and click **Next**.

- If you are prompted to stop your web server, click **Yes** to allow the Installation Wizard to stop your web server and continue with the Reporting Suite installation.

- If you are prompted to enable Web Service Extensions, click **Yes** to allow the Installation Wizard to enable Web Service Extensions and continue with the Reporting Suite installation.

The Server Activation page opens.

**To request an Activation Code**

10 The Server Activation pages request information about your installation. You must provide this information to request a software Activation Code for your MicroStrategy installation. You have 30 days to activate your installation. Click **Next**. The Server Information page opens.

11 Specify information about your Intelligence Server installation. Enter the following characteristics:

- **Name**: Distinguishes the name of this Intelligence Server installation from any other Intelligence Server installations in your company

- **Location**: Physical location of the machine on which Intelligence Server is installed

- **Use**: Description of how Intelligence Server is used

Click **Next**. The Installer Information page opens.

12 Specify contact information of the person installing the software. After your installation is complete an email containing the Activation Code is sent to the email address you confirm in this software activation step. Enter the following installer information:

- Specify whether you are an employee of the licensed company or installing on behalf of the licensed company. This installation process assumes that you select **I am an employee of the licensed company**.

- For descriptions of what information to include in the other text fields, press **F1** to view the MicroStrategy online help.

Click **Next**. The Request Activation Code page opens.
13 Select **Yes, I want to request an Activation Code**. An Activation Code is sent to the email address that you provided. This Activation Code is sent after the installation of MicroStrategy products is complete.

This Activation Code for the software is different than the Verification Code you may have received for creating your MicroStrategy account.

Click **Next**. The Microsoft Office Configuration page opens.

**To complete the installation**

14 Accept all defaults to add the MicroStrategy Office toolbar to the Microsoft Office applications available on your machine. Click **Next**. The Start Copying Files page opens.

15 This page provides information about the Reporting Suite installation you are completing. Click **Install** to continue with the installation process, which can take several minutes depending on your computer's hardware configuration.

16 After installation is complete you are prompted to view the MicroStrategy Readme. Click **Yes** to open the MicroStrategy Readme and review it as necessary. The InstallShield Wizard Complete page also opens.

For steps to access the MicroStrategy Readme and other documentation at a later time, see *Additional Resources, page 95*.

17 Select **Yes, I want to restart my computer now** and click **Finish**. This restart may take more time than a normal restart of your system as components required to support MicroStrategy are installed or updated during this restart.

**To activate your MicroStrategy installation**

18 Once your machine has been successfully restarted, the MicroStrategy Configuration Wizard opens by default. Close the Configuration Wizard.

19 Open MicroStrategy License Manager using one of the following options:

- **Windows**: From the Windows **Start** menu, point to **Programs** (or **All Programs**, depending on which version of Windows you have), then **MicroStrategy**, and then select **License Manager**. License Manager opens.

- **UNIX/Linux**: In a UNIX or Linux console window, browse to the directory you specified as the home directory during installation.
Browse to the folder bin and type ./mstrlicmgr, then press ENTER. The MicroStrategy License Manager opens.

20 Select the License Administration tab. Under Server Activation, select the Activate Server Installation option. Click Next.

21 Select the Server Activation using Activation Code option and enter your software Activation Code (which you received in an email) in the text field. Click Next to activate your software installation.

22 A verification message is displayed. Click OK to close it.

23 You must restart your Intelligence Server for the activation status to update. You can restart Intelligence Server using the MicroStrategy Service Manager. From the Start menu, point to Programs (or All Programs, depending on which version of Windows you have), then MicroStrategy, then Tools, and then select Service Manager. The Service Manager opens. You can also use the Service Manager icon available at the bottom right-hand corner on the Windows taskbar to access Service Manager.

24 You must also restart your web server for the activation status to update in MicroStrategy Web. Refer to your third-party web server documentation for steps to restart your web server.

Configuring the MicroStrategy Reporting Suite

The MicroStrategy platform contains wizards to guide you through configuring your Reporting Suite installation. Use the following list as a high-level checklist of tasks you will perform to configure your installation (steps for each task are provided below):

• Create a data source name (DSN) to connect to your database or other data source that is to store the MicroStrategy metadata repository. This is a MicroStrategy storage space for the underlying reporting components and objects you will use to create reports. One metadata repository can store information for many projects.

• Create the metadata repository in the data source you have created a DSN for.

• Establish an Intelligence Server connection to the metadata repository. This connection tells the MicroStrategy Intelligence Server where you
have chosen to create the metadata repository. Intelligence Server can connect to only one metadata repository at a time.

- Set up project sources to connect to your new metadata repository through Intelligence Server. Other MicroStrategy products connect to Intelligence Server using project sources, creating a single, communicating whole so that your reports reflect your stored data.

The following steps assume that you are configuring the Reporting Suite on a Windows platform. For detailed steps to configure MicroStrategy on a Linux, AIX, Solaris, or HP-UX platform, see the *Installing MicroStrategy on UNIX and Linux* chapter of the *Installation and Configuration Guide*.

**Prerequisites**

- You have an available data source that can store the MicroStrategy metadata. This can be an empty Microsoft Access database or another database such as PostgreSQL.

---

**To configure the MicroStrategy Reporting Suite**

**To create a DSN for your metadata repository**

This DSN connects to the data source where you plan to create the metadata repository. Be aware that the MicroStrategy metadata repository cannot be stored in a Microsoft Excel spreadsheet.

1. From the **Start** menu, point to **Programs** (or **All Programs**, depending on which version of Windows you have), then **MicroStrategy**, then **Tools**, and then select **Connectivity Wizard**. The Welcome page opens.

2. Click **Next**. A list of database drivers is displayed, as shown below. Users of the MicroStrategy platform can select the appropriate certified,
MicroStrategy-branded ODBC driver to connect MicroStrategy products to various databases and other data sources.

3 Select a database driver with which to create a DSN:

- For a Microsoft Access database, select **Other Relational Databases** and click **Next**. Select the appropriate database driver and click **Next**. Options to define the connection to your Microsoft Access data source are displayed. Complete the required information and click **OK** to create the DSN. Proceed to *To create a metadata repository, page 17*, which provides the steps to create a MicroStrategy metadata.

- For a database such as PostgreSQL or Microsoft SQL Server, select the appropriate database driver for your data source and click **Next**. The Driver Details page opens.

- For a database that is not listed in the database driver options, select **Other Relational Databases** and click **Next**. This allows you to select from all database drivers installed on your system.

4 Complete the information in the appropriate fields for connecting with the selected database driver to your data source. The information to enter varies depending on the database platform on which you are installing the MicroStrategy software.

5 Click **Test** to verify the connection. The Test Connection dialog box opens.
6 If your database requires a login and password, type the **User Name** and **Password** to connect to the database.

7 Click **Connect** to test and verify the connection. If the test is performed successfully, the connection with the database is established. If the test fails, verify the correct connection information with your database administrator and make any required changes to the information you provided in the previous steps.

8 Click **Close**, and then **Finish** to create the new DSN.

**To create a metadata repository**

9 From the **Start** menu, point to **Programs** (or **All Programs**, depending on which version of Windows you have), then **MicroStrategy**, and then select **Configuration Wizard**. The Welcome page opens.

10 Select the first option, **Create Metadata, History List, and Statistics Repository Tables**, as shown below. Then click **Next**.
11 Clear the **History List Tables** and **Statistics Tables** check boxes, leaving only the **Metadata Tables** check box selected, as shown below. Then click **Next**.

![Configuration Wizard](image1.png)

12 From the **DSN** drop-down list, select the DSN that you created above for your metadata repository, as shown in the sample image below. If your database requires a login and password, type the **User Name** and **Password** to connect to the database. Then click **Next**.

![Configuration Wizard](image2.png)

13 Review the summary of the tasks that are to be completed, and click **Finish**. The system creates a metadata repository within your database.
When the process is complete, click **Close**. You are returned to the first page of the Configuration Wizard. You have now created the metadata repository, a storage space for the objects you will use to create reports and other MicroStrategy components.

**To establish an Intelligence Server connection to the metadata repository**

14 If the Configuration Wizard is not open, from the **Start** menu, point to **Programs** (or **All Programs**, depending on which version of Windows you have), then **MicroStrategy**, and then select **Configuration Wizard**. The Welcome page opens.

15 Select the second option, **Configure Intelligence Server**, as shown below. Then click **Next**.

16 Select the same DSN that you created for your metadata repository from the **DSN** drop-down list, as shown below. If your database requires a
login and password, type the **User Name** and **Password** to connect to the database. Then click **Next**.

17 Use the default MicroStrategy administrator account to connect to the database, by typing **Administrator** as the **User Name**. The default account does not use a password, so keep the **Password** field blank, as shown in the sample image below. Click **Next**.

You can configure security in MicroStrategy at a later time. To configure MicroStrategy user accounts that help define the
security of your MicroStrategy system, see *Additional Security Configurations, page 77.*

18 On the Server Definitions page, in the **Name** field, type a name for this Intelligence Server or accept the default machine name. Leave the remaining default settings as shown below. Then click **Next.**
19 Select the **Start Intelligence Server when finished** check box, as shown below. Then click **Next**.

If you receive a message that the default port number is already in use, type a new port number in the **Port number** field. Contact your system administrator for guidance in selecting a port number.

20 Review the summary of the tasks that are to be completed, and click **Finish**. The system configures Intelligence Server. When the process is complete, click **Close**. You are returned to the first page of the Configuration Wizard. You have now connected MicroStrategy Intelligence Server to the metadata repository.

**To set up a project source that connects to the metadata repository through Intelligence Server**

21 If the Configuration Wizard is not already open, from the **Start** menu point to **Programs** (or **All Programs**, depending on which version of Windows you have), then **MicroStrategy**, and then select **Configuration Wizard**. The Welcome page opens.
22 Select the third option, Create Project Sources, as shown below. Then click Next.

![Configuration Wizard](image)

23 Type a name for your new project source in the Project Source Name field, as shown in the sample image below.

![Configuration Wizard](image)

24 Select the MicroStrategy Intelligence Server (3 Tier) option as shown above. Then click Next.
25 From the **MicroStrategy Intelligence Server Machine Name** drop-down list, select the machine name where Intelligence Server is installed. This screen is shown below. You can also type the machine name where Intelligence Server is installed. Then click **Next**.

**Note the following:**

- If you changed the default port number when you configured Intelligence Server above, type the new port number in the **Port number used by MicroStrategy Intelligence Server** field.

- You can keep the default setting for **Connection times out after (mins)**. This option determines how long a connection to a project source can be idle before the connection is ended.
26 Select an authentication method, as shown in the sample image below. Use standard authentication (the second option from the top) if you are unsure which method to use. Then click Next.

27 Review the summary of the tasks that are to be completed, and click Finish. The system creates and configures your project source. When the process is complete, click Close. Then click Exit.

Now that you have completed the initial configuration of the MicroStrategy Reporting Suite, you can begin to create your MicroStrategy project. The steps to connect to your data source and create a MicroStrategy project are described in Chapter 2, Creating a MicroStrategy Project with Your Data.
CREATING A MICROSTRATEGY PROJECT WITH YOUR DATA

Introduction

To support your reporting environment, you must first integrate your data into MicroStrategy. This chapter describes how to integrate your data into a MicroStrategy project, which contains your reports and reporting objects. Use these steps to jump-start your MicroStrategy project.

Design a project, attributes, facts, and hierarchies

You create a project by mapping physical data structures from your data source (the tables and columns in which your data is stored) to your MicroStrategy metadata repository. Then you can create reporting objects and reports based on your physical data. The reporting objects and reports that you create are stored in the metadata repository. You use MicroStrategy Architect to create projects.

The basic objects required for any reporting project are attributes, facts, and hierarchies. Each is described below as you create it.
Use the following list as a high-level checklist of tasks you will perform to create a project, attributes, facts, and hierarchies (steps for each task are provided below):

• Create a DSN to connect to your database or other data source, which stores the information for your business in the data source of your choice.

• Create a database instance that tells the MicroStrategy Reporting Suite how to connect to and access your data source. Database instances are MicroStrategy objects that use the DSN you created to connect to a database or other data source.

• Create a MicroStrategy project that will contain your reports and reporting objects.

• Use MicroStrategy Architect to create the objects required to design reports in your project.

While performing the steps below, if you encounter a scenario with your data or environment that requires some special handling, see the MicroStrategy Project Design Guide for complete details related to project, attribute, fact, and hierarchy design and creation.

If you prefer to follow a guided tutorial to create a sample project using sample data, follow the steps in the Building a Reporting Application chapter in the Introduction to MicroStrategy: Evaluation Guide.

Prerequisites

• You have an available data source that contains the information for your business. This can be a Microsoft Access database, Microsoft Excel spreadsheet, or some other database or data source.

To design a project, attributes, facts, and hierarchies

To create a DSN for the data source which stores your data warehouse

Establishing communication between MicroStrategy and your databases, Microsoft Excel spreadsheets, or other data sources is an essential first step in configuring a MicroStrategy project for reporting and analysis of your data. For information on preparing a Microsoft Excel spreadsheet for use as a data source in MicroStrategy, see the Connect to Excel files section in the Advanced Reporting Guide.
1 From the Start menu, point to Programs (or All Programs, depending on which version of Windows you have), then MicroStrategy, then Tools, and then select Connectivity Wizard. The Welcome page opens.

2 Click Next. A list of database drivers is displayed, as shown below. Users of the MicroStrategy platform can select the appropriate certified, MicroStrategy-branded ODBC driver to connect MicroStrategy products to various databases and other data sources.

3 Select a database driver with which to create a DSN:
   - For a Microsoft Access database or Microsoft Excel spreadsheet, select Other Relational Databases and click Next. Select the appropriate database driver and click Next. Options to define the connection to your Microsoft Access or Excel data source are displayed. Complete the required information and click OK to create the DSN. Proceed to **To open MicroStrategy Desktop to begin project creation, page 30**, which provides the steps to open MicroStrategy Desktop.
   - For a database such as PostgreSQL or Microsoft SQL Server, select the appropriate database driver for your data source and click Next. The Driver Details page opens.
   - For a database that is not listed in the database driver options, select Other Relational Databases and click Next. This allows you to select from all database drivers installed on your system. Select the appropriate database driver and click Next.
4 Complete the information in the appropriate fields for connecting with the selected database driver to your data source which stores your data warehouse. The information to enter varies depending on the database platform on which you are installing the MicroStrategy software.

Ensure that you provide a descriptive name for the DSN so that you can distinguish it from the DSN you created for the MicroStrategy metadata.

5 Click Test to verify the connection. The Test Connection dialog box opens.

6 If your database requires a login and password, type the User Name and Password to connect to the database.

7 Click Connect to test and verify the connection. If the test is performed successfully, the connection with the database is established. If the test fails, verify the correct connection information with your database administrator and make any required changes to the information you provided in the previous steps.

8 Click Close, and then Finish to create the new DSN.

To open MicroStrategy Desktop to begin project creation

9 Open MicroStrategy Desktop. To do this, from your Start menu, select Programs (or All Programs, depending on which version of Windows you have), then MicroStrategy, then Desktop, then select Desktop again.

10 Log in to your project source using the default MicroStrategy administrator account, by typing Administrator as the User Name. The default account does not use a password, so keep the Password field blank, as shown in the sample image below.

If you have installed the MicroStrategy Tutorial or the MicroStrategy Analytics Modules, additional project sources may
be displayed. Log in to the project source you created to connect to your data.

11 A message is displayed that no projects are available. Click OK to close this message as you will create a project using the steps below.

To connect to your data source

12 In Desktop, with your project source expanded in the Folder List, expand Administration, then expand Configuration Managers, and select Database Instances.
13 Right-click in any empty space on the right, and select **Database Instance Wizard**, as shown below:

14 In the Database Instance Wizard, click **Next**.

15 Define the connection between the MicroStrategy Reporting Suite and your data source:

- In the **Name** field, type a name for the database instance. This name will identify the Reporting Suite connection to your data source. For example, you can type the name MicroStrategy Reporting Suite.
From the **Database Type** drop-down list, select the type of database you use to store your data, as shown below.

- If your database is not listed, select the **Generic** database type. Then click **Next**.

16 Select the DSN that defines the connection information to the data source that contains your data warehouse. Use the DSN you created previously in these steps. Then type credentials in the **Database login information** fields:

- If your database requires database login credentials, type the user name and password for an account that has access to the database and database tables. Contact your database administrator for database login credentials.

- If your database does not require database login credentials, you can type any user name and leave the password blank.

17 Click **Next**. Then click **Finish**. Your new database instance is created and displayed in Desktop. Now that you have MicroStrategy connected to your data source, you can create your MicroStrategy project.

**To create a project to contain your MicroStrategy reports and reporting objects**

18 If you need to log in again, in MicroStrategy Desktop, log in to the project source you created in *To set up a project source that connects to the metadata repository through Intelligence Server, page 22*. 
19 In Desktop, from the Schema menu, select Create New Project. The Project Creation Assistant opens.

20 Click Create Project. The New Project dialog box opens.

21 Type a name and description for your new project, as shown below. Then click OK. The New Project dialog box closes and your new project is created. You now have the foundation built for your project.
22 In the Project Creation Assistant, click **Architect**, as shown below:

Do not click **Select tables from the Warehouse Catalog**. The steps below show you how to add tables to your project using Architect.

The Warehouse Database Instance dialog box opens.

23 In the Warehouse Database Instance dialog box, use the drop-down list to select the database instance which you created above. This is the main source of data for your MicroStrategy application. This step is shown
below. Once you have selected the database instance, then click **OK**. MicroStrategy Architect opens.

![MicroStrategy Architect](image)

**24** From the **Architect Button** menu, select **Settings**. The MicroStrategy Architect Settings dialog box opens, which lets you configure MicroStrategy Architect.

The Architect Button is in the top-left corner of the Architect interface, and is shown in the image below.

Select the following options:

a. On the **Configuration** tab, select the **Update schema after closing Architect** check box.

b. On the **Metric Creation** tab, select the aggregation functions used to automatically create metrics when a fact is created for a project. A separate metric is created to support each aggregation of a fact. You
can allow the automatic creation of metrics using the aggregation functions listed below:

– **Avg**: Create metrics that perform an average calculation on the fact expression.

– **Sum**: Create metrics that perform a summation calculation on the fact expression.

– **Count**: Create metrics that perform a count calculation on the fact expression.

– **Min**: Create metrics that perform a minimum calculation on the fact expression.

– **Max**: Create metrics that perform a maximum calculation on the fact expression.

– **Var**: Create metrics that perform a variance calculation on the fact expression.

The metrics are created in the Public Objects/Metrics folder of a MicroStrategy project.

You can click **Advanced Options** to open the Advanced Options dialog box, which lets you define metric naming conventions. When a metric is created for an aggregation function, the metric naming convention for that aggregation function is used to define the name for the metric. Click **OK** to save any changes you make to metric naming conventions.

The remaining options in this dialog box define how Architect displays data, maps schema objects, and loads the Warehouse Catalog. Click **OK** to accept the default settings for these remaining options.

To access these options at a later time, from the **Architect Button** menu in Architect, select **Settings**.

**25** In MicroStrategy Architect, from the **Home** tab, in the **View** area, click the **Logical View** toolbar option. This step is shown in the image below.
Then in the same View area, click the arrow icon () to access and select all of the following check boxes:

- Display available columns on logical tables
- Display used columns on logical tables
- Display attribute forms on logical tables

26 From the Design tab, in the Auto Recognize area, click the arrow icon (), as shown in the image below.

![Image of Auto Recognize option](image)

The Automatic Schema Recognition dialog box opens. Select the Auto recognize option. This option automatically defines how attributes and facts are created when tables are added to the project using Architect, based on column names and data types. For complete information on how to define these options to create and map attributes, see the Project Design Guide.

**To create and add attributes, facts, and hierarchies to your project**

27 Within MicroStrategy Architect, you can now begin to create attributes, facts, and hierarchies for your project.

At any point during project creation you can click the Save icon on the toolbar to save your progress. To close Architect, from the Architect Button menu, select Close. The Schema Update dialog box opens. Ensure the check boxes are all selected and click Update. Then select OK to close the Project Creation Assistant. To re-open MicroStrategy Architect to continue project creation, in MicroStrategy Desktop, log in to a project, and from the Schema menu, select Architect.

28 On the left side of MicroStrategy Architect, expand your new database instance. All the tables that contain your data in your data source are
displayed on the left, as shown in the example image below. This is a live view into your data source.

MicroStrategy Architect provides Undo and Redo options to make creating a project easier.

On the left, identify the tables that contain data that you want to include in your MicroStrategy project.

For example, to create reports that show sales data, choose tables that store sales data. To report on sales by month, quarter, and year, you must also choose tables that contain dates when sales transactions occurred. If you are unsure which data you need, you might benefit from choosing all available tables.

Then click and drag the tables you need from the left, and drop them onto the pane in the center. You can select multiple tables by holding CTRL or SHIFT while clicking the tables.
As you drop the tables onto the pane in the center, a Results Preview dialog box opens, as shown below.

The Attribute tab and the Fact tab of this dialog box display the attributes and facts that can be created automatically for the tables selected, based on schema creation heuristics. To create an attribute or fact automatically, select its associated check box. Clearing a check box for an attribute or fact excludes that attribute or fact from the automatic creation process. Once you have selected the attributes and facts that are to be automatically created for the tables, click **OK**.

When Architect creates attributes and facts automatically, the names of the objects are determined by the column names that store your data in your data source. To rename an attribute or fact to better reflect your data, right-click the attribute or fact within a table that you have added to the project, and select **Rename**. Type a new name for the object and click **OK**.
Once all attribute and fact selections are made, the tables are displayed along with column names from within each table, as shown in the example below:

![Image of MicroStrategy Reporting Suite](image)

Notice in the example above that facts and attributes have been created based on schema creation heuristics. Yellow block icons are displayed to represent attributes, while icons displaying the # symbol are displayed to represent facts. For details on identifying data that is useful to become an object in the project, see The Context of Your Business Data: Attributes and The Building Blocks of Your Business Data: Facts chapters in the Project Design Guide.

### To create attributes and attribute forms

An attribute represents a concept that provides context to your business calculations. For example, a long list of revenue data is not helpful unless it is displayed in the context of time (for example, revenue last month), geographical region, business unit, or product line. When designing reports, you place attributes on a report to tell the MicroStrategy Reporting Suite to use the column of data in your data source that is associated with that attribute. The Reporting Suite can then display the related data on that report.

Attribute forms are mapped to columns in the data source that provide more descriptive information on attributes. For example, a Customer attribute requires attribute forms to provide customer first names, last names, email addresses, gender, and so on. This information is often stored in a data source as columns that contain descriptive information in a character format.
32 When you have finished dragging all the tables that you need, with Architect still open, identify the column name or names from each table on the right that can provide useful contextual information for the data in your project. You can identify columns to create attributes and attribute forms using the following best practices:

- Attributes and attribute forms are automatically created for you based on schema creation heuristics, which use column names and data types to automatically create attributes and attribute forms. For further explanation of these rules and how to define them, see the Creating a Project Using Architect chapter of the Project Design Guide. If a column is automatically created as an attribute or attribute form that does not fit your reporting needs, right-click the attribute or attribute form and select Remove. You can then map the column to the correct attribute or attribute form.

- Attributes can be created based on an ID column, which defines the individual elements of each attribute. An ID column contains unique values which are commonly numeric values such as 1, 2, 3, and so on. When choosing the ID column to create an attribute, make sure that all values in the column are unique and that it does not contain NULL values. You should never use a column that has NULL or repeated values as the ID column for an attribute. Doing so results in unexpected behavior and errors.

- Once an attribute is created, you can create attribute forms for the attribute to display additional information.

Once you have identified data that should be mapped to attributes, you can create attributes as described below:

- If all the attributes for your project have been created successfully using the automatic schema creation heuristics, you can skip manual attribute creation process and begin To create facts, page 43.

- If some columns of data still need to be mapped to attributes, you can create attributes manually. Right-click a column name that contains data to make available in the project as contextual information, and select Create Attribute as shown below.
Type a name for the attribute. This is the name report designers and business users will see, so be sure that it makes sense to others. Repeat this until you have created attributes for all the columns of data that you need.

To add a column as an attribute form of an attribute, select an available column in a table, then drag and drop it onto an attribute within the same table, as shown in the step-by-step images below. A new attribute form is created for the attribute.

To create facts

Facts are used to create metrics. When designing reports, you place metrics on a report. Metrics display data based on fact definitions. Including a metric on a report tells the system to locate the column of data in your data source that is associated with the fact or facts used to define the metric. The system can then calculate and display the related data on that report.

With Architect still open, ensure you are still in the Project Tables View to identify columns in your warehouse tables on the left that contain data
suitable to become a fact. You can identify columns to create facts using the following best practices:

- A fact has two characteristics: it is numeric, and it is aggregatable. Examples of common facts include sales dollars, units sold, profit, and cost. In a Human Resources department, facts might include tenure and compensation amount.

- Facts are created automatically based on schema creation heuristics, which use column names and data types to automatically create facts. For further explanation of these rules and how to manually define them, see the *Creating a Project Using Architect* chapter of the *Project Design Guide*. If a column is created as a fact that does not fit your reporting needs, right-click the fact and select **Remove**.

Once you have identified data that should be mapped to facts, you can create facts as described below:

- If all the facts for your project have been created successfully using the automatic schema creation heuristics, you can skip the manual fact creation process and begin *To create attribute relationships, page 44*.

- If some columns of data still need to be mapped to facts, you can create facts manually. Right-click a column name that contains data to make available in the project as a fact, and select **Create Fact** as shown below.

![Create Fact](image)

For detailed examples of how to identify and create facts, see *The Building Blocks of Business Data: Facts* chapter in the *Project Design Guide*.

**To create attribute relationships**

34 When you are finished identifying and creating attributes and facts, with Architect still open, click the **Hierarchy View** tab, as shown in the image.
below. The attributes you created are displayed; each attribute is a yellow block shape.

![Image of MicroStrategy Architect with attributes and hierarchy view]

35 In the Architect toolbar, from the Home tab, in the Hierarchy area, select **System Hierarchy View** from the drop-down list. You can now begin creating relationships between attributes.

Creating attribute relationships is an essential step in defining the data stored in your data source. The MicroStrategy Reporting Suite uses this information to determine how to combine and calculate data on reports, and to provide a logical path to navigate through the data on a report.

a To create attribute relationships, on the Design tab, in the Auto Recognize area, click the **Recognize Relationships** toolbar icon, as shown in the image below.

![Image of Auto Recognize toolbar]

The System Hierarchy dialog box opens.

b You can select from the following options to automatically define attribute relationships. It is recommended that you select all the available options:

- **Based on Primary Keys/Foreign Keys**: Creates attribute relationships based on the primary keys and foreign keys defined
on your tables. Each attribute that acts as a foreign key of a table is defined as a parent attribute of each attribute that acts as a primary key of the same table. The attribute relationship is defined as a one-to-many relationship from the foreign key attribute (parent attribute) to the primary key attribute (child attribute). This option is ignored if the data source that contains the tables does not support primary keys and foreign keys.

– **Based on lookup tables:** Creates attribute relationships based on lookup tables that do not include primary key or foreign key information. Each attribute that defines a table as its lookup table is defined as a child attribute of all other attributes in the same table, that do not define the table as its lookup table. Each attribute relationship is defined as a one-to-many relationship from the parent attribute to the child attribute.

– **Based on sample data from the table:** Creates attribute relationships for attributes that share the same lookup table. Architect analyzes sample data for the table. The attributes with fewer distinct values are defined as parents of the attributes with more distinct values, using a one-to-many relationship from the parent attribute to the child attribute. For example, a lookup table includes four rows of data, which include data related to year and quarter. Each row includes the same year (for example, 2009), but the quarter changes for each row (Q1, Q2, Q3, Q4). In this case, the Year attribute is created as a parent of the Quarter attribute.

c Once you have selected the appropriate options, click **OK** to allow Architect to automatically define attribute relationships.

After all attribute relationships are determined by the rules that you selected, Architect performs a final analysis on the attribute relationships that are to be created. Any attribute relationships that are found to be redundant are not created. This ensures that attribute relationships are created that properly reflect the design of the data in your data source.

d To modify the type of relationship used to relate two attributes, right-click the relationship line between the two attributes and select one of the following types of relationships:

– **One-to-many:** Each element in the parent attribute corresponds to one or more elements in the child attribute, and each child attribute corresponds to one and only one element in the parent attribute. This is the most common type of attribute relationship. A Year attribute has a one-to-many relationship to a Quarter attribute. One year has many quarters, but a specific quarter can
be in one year only. This assumes that quarters are defined with an accompanying year such as Q4 2008, Q1 2009, and so on.

- **One-to-one**: Each element in the parent attribute corresponds to one and only one element in the child attribute, and each child attribute corresponds to one and only one element in the parent attribute. A common example of a one-to-one relationship is citizen and taxpayer ID. A citizen can have only one taxpayer ID and a taxpayer ID can be assigned to only one citizen.

- **Many-to-many**: Each element in the parent attribute can have multiple children and each child element in the child attribute can have multiple parents. In banking, customers and accounts are an example of a many-to-many relationship. One customer may have many accounts, and each account may be associated with many customers, such as in the case of a joint checking account.

For examples and additional details for creating attribute relationships, see the *The Context of Your Business Data: Attributes* chapter in the *Project Design Guide*.

**To create hierarchies**

It is easier for report designers to locate appropriate attributes to use on reports if those attributes are grouped together in the project in a logical way that makes sense for your business goals:

- For example, if many reports will contain a time-related attribute so that reports can display week, month, year, or all three, then it makes sense to include all time-related attributes in a single group. These groups, used for attribute browsing purposes, are called hierarchies. When the report designer browses for objects to place on a report, the designer can open a folder for the Time hierarchy to see and use all attributes related to time.

- Common hierarchies in a retail organization might include Time (made up of attributes such as Day, Month, Year); Geography (made up of attributes such as Store, State, Region, Country); or Product (made up of attributes such as Item, Subcategory, Category.)

Group attributes together into a hierarchy by simply dragging a selection box around a set of attributes. Once selected, from the **Home** tab, in the **Hierarchy** area, select **New Hierarchy**. Type a name to identify the hierarchy. (Report designers will use this name to know what reporting objects are in that group of objects, so make sure the name makes sense for your users.) Click **OK**.
37 Inside each hierarchy, you can then select and drag between two attributes to define that one attribute can browse to another attribute. A line appears which reflects a browse path between those attributes. Analysts of report data will use these browse paths to drill up or down on a report, from a high summary level of data to a low detailed level of data, and vice versa. For example, an analyst might want to drill from a summarized report on annual revenue, down to detailed monthly or daily revenue data. As another example, a Time hierarchy with defined browse and drilling paths is shown below.

For examples and additional details for creating hierarchies, see the Creating Hierarchies to Organize and Browse Attributes chapter in the Project Design Guide.

To save your progress and exit MicroStrategy Architect

38 When you are finished creating attributes, facts, and hierarchies, click Save to save all your changes. Then from the Architect Button menu, select Close to close Architect. The Schema Update dialog box opens.
39 Make sure that the check boxes are all selected and click **Update**. Then select **OK** to close the Project Creation Assistant.

**To view your new project**

40 In MicroStrategy Desktop, expand your project in the Folder List on the left, then expand the **Schema Objects** folder, and then select the **Attributes** folder as shown below. Your new attributes are displayed on the right. Report designers can now use these objects by adding them to reports, based on what the report is intended to display.

Next, you design another important object for report designers to use on reports, namely metrics.

**Design metrics**

A metric is a business calculation. It provides the numbers you see on a report.

To create a metric, you use the facts you created in Architect above and place them into mathematical expressions to become metrics. A fact by itself simply lists numbers, such as revenue, number of items sold, or cost. A metric incorporates the information provided by the attributes on a report.
and aggregates the fact data to provide meaningful business measurements such as key performance indicators (KPIs).

Note the following:

- MicroStrategy Architect can automatically create metrics when facts are added to your project. Steps on how to configure this automatic creation of metrics are provided in To create a project to contain your MicroStrategy reports and reporting objects, page 33. Metrics created in this way are stored in the Public Objects/Metrics folder of a MicroStrategy project.

- By default, facts are created in the Schema Objects/Facts folder of a MicroStrategy project.

For example, if you place a Revenue metric on a report, along with the Year attribute and the Month attribute, you can view your organization’s revenue data displayed for each month and year that you store data in your data source.

MicroStrategy can define any business measure, from simple SUM metrics, to advanced statistical calculations, to data mining predictions.

Use the steps below to create metrics, based on the facts you created above. For additional examples of metric creation, see the Building Query Objects and Queries, for Designers chapter in the MicroStrategy Basic Reporting Guide. To create more complex metrics, for example a metric that aggregates data based on a specific attribute in the report, see the Advanced Metrics chapter in the MicroStrategy Advanced Reporting Guide.

To create and add a metric to your project

1 If you need to log in again, in MicroStrategy Desktop log in to the project source you created in To configure the MicroStrategy Reporting Suite, page 15.
2 In the Folder List on the left side, expand the new project you created, expand the **Public Objects** folder, and click the **Metrics** folder. This folder is where you create and save your new metrics. It is shown below.

![Image of MicroStrategy Desktop interface](image1.png)

3 In the area on the right, right-click, point to **New**, and select **Metric**. In the New Metric dialog box that opens, click **OK**. The Metric Editor opens, as shown in the image below.

![Image of Metrics Editor](image2.png)
4 In the Object Browser on the left, select a fact that you want to be part of the metric’s calculation. Then drag and drop the fact into the Definition pane at the bottom right. A basic metric expression is automatically created, using the fact you chose and the function SUM.

You can change the function and any other aspect of the metric’s expression. Click $f(x)$ above the expression to access the Functions Library, where you can choose from over 250 functions available in MicroStrategy. Your metric expression can be as simple or as complex as you choose to make it, depending on your business users’ requirements for data calculation.

5 By default, metrics are calculated at the level of the attributes on the report. For example, a report contains a Revenue metric and the attribute Year. The metric is automatically calculated to display revenue for each year in your data source. When the same Revenue metric is placed on a report containing the Customer attribute, the revenue is calculated for each customer.

Additional settings that govern how metrics are calculated are covered in detail with examples in the Advanced Metrics chapter in the Advanced Reporting Guide.

6 To save the metric, click **Save and close**. Type a name for the metric and click **Save**. The metric is now saved in the Metrics folder, and is available for use by other MicroStrategy Reporting Suite users.

Repeat the steps above to create additional metrics based on your facts.
Introduction

Reports display your business data, and are the focus and goal of business intelligence. You perform data analysis on reports to gather business insight. The results displayed in any MicroStrategy report are often a starting point for further investigation.

Create a report

You create reports by placing MicroStrategy objects on the report. These objects include such things as attributes, metrics, filters, prompts, custom groups, and consolidations. The attributes and metrics you have created thus far are sufficient to begin creating reports.

- Attributes provide descriptive information about your business. Examples of attributes include such concepts as Year, Month, Day, Region, State, City, Product Category, Subcategory, Item, and so on. Attributes provide context for the calculated data displayed on the report. By default, attributes are stored in the Schema Objects/Attributes folder of a MicroStrategy project.
- **Metrics** are the business calculations you want to analyze. Examples of metrics include Revenue, Profit, Cost, Percentage of Sales, Number of Items Sold, and so on. Metrics are commonly stored in the Public Objects/Metrics folder of a MicroStrategy project.

For detailed information and examples about other MicroStrategy reporting objects, see the *MicroStrategy Basic Reporting Guide*.

---

**To create a report**

1. If you need to log in again, in MicroStrategy Desktop log in to the project source you created in *To establish an Intelligence Server connection to the metadata repository, page 19*.
   
   Use the default MicroStrategy administrator account, by typing Administrator as the User Name. The default account does not use a password, so leave the Password field blank.

2. In MicroStrategy Desktop, in the Folder List on the left, expand the new project you created.

3. Expand the Public Objects folder, and then select the Reports folder. This folder is where you create and save your new reports, so that other users can access them.

   - Reports can be organized into folders and subfolders to facilitate easy navigation among your organization’s or department’s reports.
4 In the empty area on the right, right-click, point to **New**, and select **Report**. In the New Grid dialog box that opens, select **Blank Report** and click **OK**. The Report Editor opens, as shown in the example image below.

The Report Editor has four panes, which can be displayed or hidden using options in the **View** menu:

- **Report Objects pane**: At the top left, the Report Objects pane displays all objects on the report.
- **Object Browser pane**: At the bottom left, the Object Browser is where you navigate to and select objects to use on the report.
- **Report Filter pane**: At the top right, the Report Filter pane is where you define filtering conditions that restrict or refine the data displayed on the report.
- **Report View pane**: At the bottom right, the Report View pane displays the layout of the report, and is where objects appear that have been added from the Object Browser.

5 Start by defining the report content and layout, in the Report View pane. To add an attribute or metric to the report, browse to the object using the Object Browser on the bottom left. Right-click on the object in the Object Browser, and select either **Add to Rows** or **Add to Columns**.

A common practice is to place attributes on the rows and metrics on the columns.
To save your report, click **Save and close**. Type a name for the report and click **Save**. The report is saved in the Reports folder, and is available for use by all users.

You can run your new report by double-clicking the report name. Reports are displayed as tabular grids by default. You can also display reports as a graph.

From the **View** menu, select **Graph View**. Select a graph type and style to display the report as. For additional information on displaying a report as a graph, see *Create a graph, page 56*.

### Create a graph

Graphs efficiently communicate information to help users gain quick insights such as identifying trends and patterns, and spotting outliers, by simply glancing at visual representations of the data. MicroStrategy gives users a quick way to create and format a broad range of graphs and charts. Almost any report can be turned into a graph.

While performing the steps below, if you encounter a scenario with your data or environment that requires some special handling, see the *MicroStrategy Basic Reporting Guide* for complete details related to graph reports. For advanced topics in graphing data, see the *MicroStrategy Advanced Reporting Guide*.

---

**To create a graph**

1. In Desktop, double-click the report to run it.
View a report in graph view

2 From the View menu, select Graph view. The Graph Type dialog box opens.

3 Select the graph style that best fits your data. For your first few graphs, use one of the following graph styles as these fit most sets of data. These styles require at least one attribute and one metric in your report:

- Area
- Bar
- Line
- Pie

For a table showing the exact requirements that a report must meet to be displayed successfully in a given graph style, see the Graphing chapter in the Advanced Reporting Guide.

4 Click OK. The Graph Type dialog box closes and the report is displayed as a graph.

Add additional attributes or metrics to the graph

5 From the View menu, select Design View. In this view, you can make changes to the graph and see the immediate effect of those changes.

6 If the report is displayed as a grid in Design View, click the Switch To Graph icon to view it as a graph.
On the toolbar, click the **Show Drop Zones** icon. The drop zones for the graph are displayed, as in the image below:

![Object Browser and Report View](image)

To add an attributes or metric to the graph, browse to the attribute or metric in the Object Browser (shown in the image above), then click and drag the attribute or metric into the appropriate drop zone. It is shown immediately on the graph.

The metrics are all displayed on the same axis. You can switch the axis on which the attributes and metrics are displayed by dragging and dropping them onto the Series or Categories axes.
**Customize the appearance of the graph**

9 To customize the appearance of your graph, right-click anywhere in the graph and select **Graph options**. The Graph Preferences dialog box opens.

The Graph Preferences dialog box contains different settings depending on the type of graph used to display the data.

10 On the left, expand the category corresponding to the option you want to change, and change the settings. For example:

- To display a title on the graph, expand the **Titles** category, select **All**, and select the **Title** check box.

- To add a border to the graph, expand the **Background** category, select **Border**, and specify the line style, color, line thickness, and transparency of the border.

- To change the font of the axis labels, expand the **Axes** category, select **All Axes**, and specify the font name, font size, and text effects such as bold, underline, or italic.

A preview of the graph is provided so that you can view how the graph will change with each formatting option.

11 To apply your changes to the graph, click **Apply**. To apply your changes and close the Preferences dialog box, click **OK**.

12 When you are ready to save your graph, click **Save and close**. The graph is saved in the Reports folder, and is available for use by all users.
This single report definition is used to display both the grid view of the data and the graph view of the data. You can switch between the grid view and the graph view by running the report and selecting **Grid View** or **Graph View** from the **View** menu.
EXPLORING DATA IN MICROSTRATEGY WEB

Introduction

MicroStrategy Web is the MicroStrategy product you use to easily analyze and interact with your data as it is displayed in reports and documents. MicroStrategy Web lets you view and interact with data from any computer that has a browser.

For full details, images, and examples on any of the features described below, see the MicroStrategy Basic Reporting Guide.

Go live with MicroStrategy Web

To make your projects available through MicroStrategy Web, you must first connect MicroStrategy Web to Intelligence Server. To support this connection, a web server such as Microsoft Internet Information Services must be installed on the MicroStrategy Web server machine. Once the connection has been established, users can log into MicroStrategy Web with just the URL for your MicroStrategy Web server and a MicroStrategy login and password. Use the steps below to connect Web to Intelligence Server.
To connect MicroStrategy Web to MicroStrategy Intelligence Server

1. From the Start menu, point to Programs, then MicroStrategy, then Web, then Web Administrator. The MicroStrategy Web Administrator page opens in your web browser, as shown in the sample image below.

2. In the Add a server manually field, type the name or IP address of your Intelligence Server.

   If your Intelligence Server is on the same machine as your Web server, you can type localhost in the Add a server manually field.

3. Click Connect. MicroStrategy Web attempts to connect to the Intelligence Server. When the connection is complete, the server is listed in the Web Administrator's Connected Servers list, as shown in the image below.
To connect to your project in MicroStrategy Web

4 At the top of the Web Administrator page, click MicroStrategy Web Home. The MicroStrategy Web home page opens, with a list of the projects available on this Intelligence Server.

5 Click your project. A login screen opens.

6 To log in to the project, use the default MicroStrategy administrator account by typing Administrator as the User Name, with a blank password. (The default account does not use a password.) Then click Login.

You can now browse your project in MicroStrategy Web, run reports, and explore your data.
Run reports and explore the data

Each project that you log into in MicroStrategy Web opens the project’s Home page, which provides links at the top of the page to different areas of the project:

- **Shared Reports** is a link to a common report library for all users.
- **My Reports** is a link to each users’ favorite reports.
- **History List** is a link to stored reports that have been run on a schedule and delivered to the History List folder.
- **My Subscriptions** is a link to a list of scheduled reports, where you can manage subscriptions to scheduled reports.
- **Preferences** is a link to settings where you can change the default behavior of various MicroStrategy Web features.
- **Search** locates reports and reporting objects in the project.

Help and Logout links are also available at the top of any page.

You can view and interact with reports using the following steps.

If you encounter scenarios or questions not covered by this guide, see the *MicroStrategy Basic Reporting Guide* for details on all options in the software.

---

To browse a project and run a report


   Use the default MicroStrategy administrator account, by typing Administrator as the **User Name**. The default account does not use a password, so leave the **Password** field blank.

2. Click **Shared Reports**. Reports that are to be shared with a user community can be stored here.

   This folder in Web displays all reports that are saved in the Reports folder in MicroStrategy Desktop. (In Desktop, from the Folder List on the left, expand Public Objects, then expand Reports.)
You can create folders to group related reports for your MicroStrategy project. Security settings can be defined to determine which folders and reports you can see.

To display the list of folders on the left as shown below, from the toolbar, click **Show Navigation Tree**.

![Image of folder structure]

3. To locate a specific report you can either navigate to the location or you can run a search to return the report:

   - To navigate to a specific report, click any folder to see the reports contained within it.

   - If you know the name of a report that you want to see, type a search term that contains one or more words of the report name. Use the **Search** field at the top right. Type the name or partial name of a report, document, or folder, depending on what you are looking for.

The image below shows a list of some sample reports within a folder in a MicroStrategy project. The different icons represent different types of reports: for example, a grid report (similar to a standard spreadsheet), a graph report, or a combination grid and graph report.
The PDF and Excel dots at the bottom of an icon identify the default output format of a report. Report icons with no dot are displayed in HTML format.

To run a report, click the report name. A sample grid report is shown in the image below.
A sample graph report is shown in the image below.

If the report you open contains a prompt, you are presented with a page of options to select before the report is displayed. A prompt is a question presented to users when they run a report, asking them to indicate what data they want to see. Select the data that you want to be displayed on the report and then click Run Report. A sample prompt page is shown in the image below. For details about answering every kind of prompt in MicroStrategy, see the Answering Questions About Data chapter in the Basic Reporting Guide. For details about creating a prompt in MicroStrategy, see
After the report is displayed, you can see the data from your data source, calculated according to the rules defined by the metrics used on the report, and aggregated to the level of the attributes in the report.

In addition to looking at the data displayed, there are some other parts of a report that provide important information about what data was filtered to be included in the calculations and what data was filtered to be excluded. The image below shows a sample report, with some important areas indicated.

6. Run reports and explore the data © 2011 MicroStrategy, Inc.
• **Report Details**: The image above shows you where you can read a description of the report, usually written by the person who created the report. The description appears in the **Report Details** area. This area also shows you what data the report filter included in the report, and what data was excluded from the report.

• **Prompt Details**: If your report included prompts, the image above shows where you can read a list of the answers you provided to the prompt questions. Your answers helped to filter the data brought back from your data warehouse. Not all reports contain prompts.

7 To interact with the data on your report, use the toolbars displayed above the report. The toolbars are highlighted in the sample report shown in the image below. (The Report Details and Prompt Details areas have been hidden from view, to display the report itself in a larger available space. To hide these areas, click ** pencilland/or ? pencil on the **Tools** menu.) To display different toolbars, click the menu tabs above the toolbar.

Common actions include the following, and can be performed by clicking the toolbar icons shown below:

• View the report in Full Screen mode:  on the **Home** menu.

• Print the report:  on the **Home** menu.

• Export the report to Microsoft Excel:  on the **Home** menu.

Groups of data from a MicroStrategy report can be displayed in separate workbook tabs in Excel. (The groups of data are selected for display using the page-by fields at the top of reports where page-by is enabled.) All Excel functionality can be used on the exported data. For example, you can modify formatting, change values, and add formulas after the data has been exported.

• Export the report to Adobe PDF:  on the **Home** menu.
• Refresh the report to display the latest data: on the Data menu.

• Schedule a report to run automatically: on the Home menu.

Scheduled reports are run at a regular time you determine, and the report results are automatically delivered to a folder named History List in your MicroStrategy project. To see a scheduled report, select History List at the top of any page. Click the History List message to see the report results.

• View subsets of data on a large report:

![Page-by](image)

For larger reports, the report’s designer may have grouped the report results so that you only see a subset of data at one time. You can select different subsets of data to view, by clicking a Page-by drop-down list. Not all reports contain page-by fields.

• Annotate a report by adding notes: on the Tools menu.

Type your comments in the box at the bottom left, then click Submit. Notes can be useful to collaborate with colleagues, or to provide guidance on how the report should be used.

• Sort data to quickly see the highest and lowest numbers. To sort, right-click any column heading, select Sort, then select Ascending or Descending. Sorting can answer such questions as, What is my most profitable product line? Who is my least productive salesperson?

• Perform an advanced sort on multiple columns: on the Data menu.

• Display totals or subtotals: on the Data menu.

Not all actions listed above may be available for every report. Some actions may not be enabled by the report’s creator.

Visualize the data

MicroStrategy provides a variety of visualization tools to derive insights from large amounts of data, and to format the information.
To visualize your report data in new ways

1. Run a report in MicroStrategy Web. Use the steps above in *Run reports and explore the data, page 64* to locate and run a report.

2. For a grid report, you can apply different layouts and formats to the data. (If your report is not displayed as a grid, from the View menu click the Grid icon.)

   To apply a different layout and format, from the Grid menu, click the Autostyles drop-down list (which displays the name of the currently selected autostyle), as shown in the image below. Then select from the many autostyles available.

3. You can resize the data display by selecting Auto Fit to Contents or Auto Fit to Window. Both are on the Grid menu.

4. You can improve the readability of the data by adding bands to the data. The sample grid report below shows the data after banding is applied, with alternate rows displayed in different colors.
5 Display the report as a graph: A graph or chart is a visual representation of the data and is often the best way to derive insight from the data, as shown in the image below.

6 To work with a graph report:

- Hover the cursor over a part of the graph, such as one of the riser bars as shown in the graph above, or a point on a line graph. The data point you are viewing is displayed in a tooltip.

- If available on the report you are viewing, use the Page-by feature described above to slice through the data.
• Display the data as both a grid and a graph:

![Data Display](image)

Drill through the data

Drilling provides a view into the details of the report’s data. When data is organized hierarchically in a storage system, the data can be displayed at a high, summarized level, and areas of interest can be investigated all the way down to a low, detailed level.

Drilling allows users to change the initial report definition dynamically without having to design and store the new reports beforehand. Drilling allows users to explore data deep within a report to identify and discover important trends in their business. In MicroStrategy, drilling always takes into consideration the privileges and security profile of each user.

For complete details on drilling, with images and examples, see the *MicroStrategy Basic Reporting Guide*.

**To drill on data in MicroStrategy Web**

1. Run a report in MicroStrategy Web. Use the steps above in *Run reports and explore the data, page 64* to locate and run a report.
In a grid report, right-click any column or row heading and select **Drill**.

From the drilling options available, choose the direction you want to drill.

For example, if you drill on a row heading named Product Subcategory, you might drill up to a higher, summary level by selecting Product Category. Or you might drill down to a lower, more detailed level by selecting Product Item.

If you drill on a time-related row or column heading, such as Month, you might drill up to a higher level by selecting Year or Quarter. Or you might drill down to a lower level by selecting Day or Week. Your organization’s data might go even lower, to Hour or Minute.

A report’s designer can also allow users to link from one report to other related reports, as shown in the image below.

Data exploration helps expand your understanding of the data in your original report, and provides critical insight to make business decisions.
Run ad hoc reports

A single MicroStrategy report can be designed so that it serves the needs of many users. To do this, use prompts. Prompts are questions presented to the user when they run a report, asking them to indicate what data they want to see.

By answering prompts, users select filtering criteria and report content dynamically each time the report is run. Prompts are the most commonly used personalization option.

For example, the prompt below is called an object prompt, a feature unique to MicroStrategy. It asks the user to select the types of objects they want to see on the report, such as attributes, metrics, and filters. With an object prompt, users can effectively design the report themselves.

Prompt questions can be displayed in a number of styles, including shopping cart, drop-down, check boxes, radio buttons, text boxes, and calendars.

Users can save their prompt answers so the same responses are used the next time the report is executed. If this same prompt is also used on a different report, the saved prompt answers will be available in the second report.

By using prompts instead of creating an individual report for each user, the total number of reports is far more manageable.
For an introduction to and examples of all the prompts you can create in MicroStrategy, see the *Building Query Objects and Queries, for Designers* chapter in the *Basic Reporting Guide*. This chapter includes a table of all prompt types, along with uses for each prompt.
Introduction

This chapter covers optional configurations for your MicroStrategy Reporting Suite. The configurations described below can help to expand your MicroStrategy Reporting Suite applications to support a larger user base.

Configure security

MicroStrategy administration is centralized in a single metadata repository, which can store information about all the different reports and objects necessary for many different business departments. Access to the reporting objects in your MicroStrategy metadata repository is restricted based on the permissions and privileges held by each individual MicroStrategy user.

Every Reporting Suite user who logs into the MicroStrategy system should have a unique MicroStrategy login. This enables system administrators to grant those users access to the appropriate data, and to track all changes made in your MicroStrategy project.
You can control access to your MicroStrategy project in three ways:

- **Privileges** control what functionality in the MicroStrategy system the user has access to. For example, a user who does not have the Use Metric Editor privilege cannot create or edit metrics. Privileges are assigned to the user’s account by right-clicking the user and selecting **Edit**.

- **Security filters** control what data the user has access to. For example, a user who has a security filter that restricts him to only the California Central Region element of the Region attribute cannot view any data for any other state. Security filters are assigned to the user’s account by right-clicking the user and selecting **Edit**.

- **Permissions** control what objects in the MicroStrategy system the user has access to. For example, a user who has the Write permission for a metric can make changes to the metric’s definition, while a user who only has the Execute permission can run reports containing the metric but cannot change that metric.

Each MicroStrategy object has an access control list (ACL), which specifies the permissions that each MicroStrategy user has for that object. Permissions are assigned to the objects in MicroStrategy by right-clicking the object, selecting **Properties**, then selecting **Security**.

MicroStrategy Reporting Suite users can be organized into user groups for convenient administration. User groups can be granted privileges, security filters, and permissions in the same way as individual users. A user can be a member of multiple groups, and inherit the security settings from each group.

For complete details related to user and object security, see the *Setting Up User Security* chapter in the *MicroStrategy System Administration Guide*.

---

**To create a user and configure its security profile**

1. If you need to log in again, in MicroStrategy Desktop log in to the project source you created in *To establish an Intelligence Server connection to the metadata repository, page 19.*
2 In Desktop, on the left side, expand **Administration** and then expand **User Manager**.

![User Manager screenshot]

To create a user

3 Right-click **Everyone**, point to **New**, and select **User**. The User Editor opens, as shown below.

![User Editor screenshot]

4 Type the basic user information, such as login name, full name, and password, in the fields. For detailed information about each field, click **Help**.
To assign privileges to the user

5 On the left side of the User Editor, under **User Definition** select **Project Access**.

6 Select the check boxes for the privileges or privilege groups you want the user to have. For a detailed description of every privilege in MicroStrategy, see the *Permissions and Privileges* chapter in the *Supplemental References for System Administration Guide*.
To assign a security filter to the user

7 On the left side of the User Editor, under **User Definition** select **Security Filter**.

8 Select your project from the **Projects that have been granted access** drop-down list and click **View**. The Security Filter Manager opens.

9 Since you are just starting out with MicroStrategy, you can create a new security filter and then assign it to the user. You can apply your new security filter to any other user you add. To create a new security filter, click **New**.
10 Create qualifications or add existing qualifications to the new security filter. These qualifications define the data the user is allowed to view on a report. To do this, double-click in the Filter Definition pane on the right. The Filtering Options pane opens.

11 Select **Add an Attribute Qualification** and click **OK**.

12 Select an attribute depending on what type of data you want the security filter to apply to:
   - To filter data related to an attribute’s form:
     a. Select the attribute whose form you want to qualify data on.
     b. In the Attribute Qualification pane, from the **Qualify On** drop-down list, click the attribute form on which you want to qualify the report.
     c. Click an operator in the **Operator** list.
     d. In the **Value** field, type the value to use to qualify on the attribute form; this is the value that will be compared against the data in your data source.
   - To filter data based on elements of an attribute:
     a. Select the attribute that has the elements on which you want to qualify.
     b. In the Attribute Qualification pane, from the **Qualify On** drop-down list, select **Elements**.
     c. From the **Operator** drop-down list, select either **In List** (to define what attribute elements the filter should include data for) or **Not In List** (to define what attribute elements the filter should exclude data for).
     d. Click **Add**.
     e. In the Available Objects list, select attribute elements and then click > to add them to the Selected Objects list. Then click **OK** to close the Selected Objects dialog box.

13 Click **OK** to close the Attribute Qualification pane.

14 For details on each option to create a security filter, click **Help**. When you are finished defining the security filter, click **Save and Close**.

15 To assign a security filter to this user, select the security filter and click >. The selected security filter is moved to the **Security Filters** area.
16 Click OK. The Security Filter Manager closes and the selected security filters are assigned to this user for your MicroStrategy reporting project and any other projects you later create within this project source.

17 Click OK. The User Editor closes and the user is created.

---

**To set permissions for a user on a specific object**

1. Browse to the object (usually an attribute or metric) that you want to set permissions for.

2. Right-click the object and select **Properties**. The Object Properties dialog box opens. On the left, select **Security**.
3 Click **Add**. The Select Desktop Users and Groups dialog box opens, as shown below.

![Select Desktop Users and Groups dialog box](image)

4 Select the **Show Users** check box.

5 In the list of users, select the user you want to change permissions for.

6 Click **OK**. The Select Desktop Users and Groups dialog box closes, and the user is listed in the **Permissions** area of the Object Properties dialog box, as shown below.

![Properties dialog box](image)
7 Locate the user name in the **User** column and click the **Object** column next to the user name. Select the desired permission from the drop-down list.

8 Click **OK**. The Object Properties dialog box closes, and the user’s permissions for the object are saved.
Introduction

This appendix provides answers and solutions for common questions and issues you may encounter when installing, configuring, or using the MicroStrategy Reporting Suite software.

Requesting or retrieving a license key

You must request a license key for the MicroStrategy Reporting Suite to install and use the software. After you request the license key, you must retrieve the license key that is sent to you.

The following steps show you how to request a license key and how to retrieve a license key after you have requested it.

To request or retrieve a license key

1. In your web browser, go to www.microstrategy.com/freereportingsoftware
2 At the top right, click **Download Now**.

3 Log into the site with your user name (your email address) and password.

4 Select one of the following:
   - **Request License Key**
   - **Retrieve Your Current License Key**

## Returning to the Reporting Suite download page

You can return to the Reporting Suite download page to retrieve your license key, download the Reporting Suite installation files, and review additional resources for installing and configuring your Reporting Suite software.

### Prerequisites

- You have previously accessed the Reporting Suite download page and requested a Reporting Suite license (see *Requesting or retrieving a license key*, page 87).

---

**To return to the Reporting Suite download page**

1 In your web browser, go to [www.microstrategy.com/freereportingsoftware](http://www.microstrategy.com/freereportingsoftware).

2 At the top right, click **Download Now**.

3 Log in to the site with your user name (your email address) and password.

4 Click **Retrieve Your Current License Key**. The Reporting Suite download page is displayed in your web browser.

## Locating the downloaded zip file

Installing the MicroStrategy Reporting Suite requires you to download a zip file to your machine. If you forget where you downloaded the zip file to, you
can locate it by searching in your machine for the appropriate file name, as follows:

- MicroStrategyWindows921.zip for Windows
- MicroStrategyLinux921.zip for Linux
- MicroStrategySolaris921.zip for Oracle Solaris
- MicroStrategyAIX921.zip for IBM AIX
- MicroStrategyUX921.zip for HP-UX

### Installing on a certified operating system

Your MicroStrategy Reporting Suite software must be installed on an operating system that is certified or supported by MicroStrategy. The list of certified and supported operating systems on which you can install the Reporting Suite software can be found in the MicroStrategy Readme file (find this file this using the steps in Accessing additional documentation resources prior to installation, page 103.)

Common installation mistakes related to operating systems include:

- Installing on versions of Microsoft Vista that are not currently certified or supported by MicroStrategy.
- Installing on older versions of Microsoft Windows that are no longer supported by MicroStrategy.

Be sure to check the list of certified and supported operating systems that MicroStrategy provides, to ensure that your machine’s operating system is listed as either certified or supported.

### Installing Microsoft IIS

If you plan to use IIS (Internet Information Systems) to deploy MicroStrategy Web, Microsoft IIS must be installed on the same machine where you install the MicroStrategy Reporting Suite software. You must also install the .ASP and .NET frameworks, if they are not already installed on the machine. These frameworks are installed by default along with IIS, in all versions of IIS except IIS version 7.
IIS is installed by default on Windows server operating systems, and is an optional component on other Windows operating systems. For information on installing IIS on your Windows operating system, refer to the third-party Microsoft documentation provided at http://www.iis.net/.

If you install IIS 7, be aware that you must also install the .ASP and .NET frameworks, if they are not already installed on the machine. To be sure these additional components are installed and enabled when you install IIS, see the steps in *Supporting MicroStrategy with IIS 7, page 90*.

If you install IIS 6 and your machine is running a 64-bit Windows operating system, you must configure some MicroStrategy products as 64-bit applications. To perform these steps, see *Supporting MicroStrategy with IIS 6 on 64-bit Windows operating systems, page 91*.

**Supporting MicroStrategy with IIS 7**

The steps below may differ slightly depending on your version of Windows. The third-party products discussed below are manufactured by vendors independent of MicroStrategy, and the steps to configure these products is subject to change. Refer to the appropriate Microsoft documentation for steps to configure IIS 7.

1. On a Windows machine, from the Start menu select **Control Panel**.
2. Double-click **Programs and Features**.
3. Click the **Turn Windows features on or off** task. The Windows Features dialog box opens.
4. Expand **Internet Information Services**, and select the following options:
   a. Expand **Web Management Tools** and select:
      - **IIS Management Console**
      - **IIS Management Scripts and Tools**
      - **IIS Management Service**
b Expand **World Wide Web Services**, then expand **Application Development Features**, and select:

- .NET Extensibility
- ASP.NET
- ISAPI Extensions
- ISAPI Filters

c Within **World Wide Web Services**, expand **Common Http Features**, and select:

- Default Document
- Static Content

d Expand **Security**, and select:

- Request Filtering
- Windows Authentication

5 Click **OK** to save your changes.

**Supporting MicroStrategy with IIS 6 on 64-bit Windows operating systems**

If you plan to use IIS 6 on 64-bit Windows operating systems, some MicroStrategy products must be configured as 64-bit applications. These requirements are described below:

- For MicroStrategy products that must be configured as 64-bit applications on 64-bit Windows operating systems, you must define the IIS parameter **Enable32BitAppOnWin64** as False (0). These MicroStrategy products include:
  - MicroStrategy Intelligence Server
  - MicroStrategy Web Server (ASP.NET)
  - MicroStrategy Mobile Web Server (ASP.NET)

See your Microsoft documentation for steps to define the **Enable32BitAppOnWin64** parameter. Information on defining this parameter is available at [http://support.microsoft.com/kb/894435](http://support.microsoft.com/kb/894435).
Resolving a JVM memory-related error

You may see an error which states that you do not have enough memory to create the JVM. This error message occurs when other processes on the machine are using or reserving memory, causing insufficient system resources.

To resolve this problem, close or otherwise disable software and processes that are using or reserving memory. You can find suggestions for this issue in the MicroStrategy User Forum at:

https://resource.microstrategy.com/forum/replylistpage.aspx?id=1231

For additional assistance with your system memory and how to disable processes, contact your system administrator.

Resolving error code 0x80070005

This error code typically means that the user account on the machine where you are trying to install the MicroStrategy Reporting Suite does not have the proper privileges to install this software.

Contact your organization’s administrator for permission or privilege issues related to your machine.

Addressing issues with number of CPUs

CPU message with activation email

You may notice that when you activate your Reporting Suite software, the activation message you receive displays a list of various statistics about the
machine on which you are installing the software. An example of this list is shown below:

The following activation information has been recorded with this activation to assist with identifying this Server Installation.

Server Installation ID: 36248
Installation Date: 7/7/2009
Installation Name: TEST-CPU
Location: John Doe's office
Usage: Development
Activation Method: Automatic
Activation ID: 5
Activation Date: 7/7/2009 1:10:21 PM
Contract ID: 10000
Operating System: Windows XP

Number of CPUs: 2


The number of CPUs listed in the activation message is a count of the physical CPUs that the activation process finds on your machine. It does not reflect the number of CPUs that the MicroStrategy software will use.

The Reporting Suite software licensing is limited to one CPU for MicroStrategy Intelligence Server. It is also limited to one CPU for MicroStrategy Web. These two products may both use the same CPU, or they may use different CPUs. However, MicroStrategy CPU usage is unrelated to the information displayed in the activation message you receive via email.

**Logging in to the Reporting Suite software**

MicroStrategy comes with a default login. The default login includes the following user name and does not have a password:

- **User Name:** administrator
- **Password:** Leave this blank

It is possible to change the default login name and password, so if the default credentials above do not work, the person who installed and configured the Reporting Suite software may have changed them.
Addressing issues with number of users

If you have chosen to install MicroStrategy’s sample Tutorial project, this project and its related project source come with a number of sample users. These sample users are included in the system’s user count for licensing purposes.

If you want to remove these sample users from the user license count, you can select all the sample users (except Administrator), right-click, and select **Disable**.
ADDITIONAL RESOURCES

Online Support, Training, and Videos

The MicroStrategy Reporting Suite site provides the following online resources:

- Online support features a full, easily searchable technical knowledge repository, aimed to ensure your success with MicroStrategy. Visit the support site at:

  https://resource.microstrategy.com/support

- Online training allows users to extend their BI knowledge via self-paced, expert instruction and product simulations on a user-friendly interface. Visit the training site at:

  https://resource.microstrategy.com/education/CourseCatalog.aspx

- Online video guides help answer immediate questions and get you jump-started in your development. See the video guides at:

  http://www.microstrategy.com/freereportingsoftware/demovideos#getstarted
Documentation

MicroStrategy provides both manuals and online help; these two information sources provide different types of information, as described below:

- **Manuals**: In general, MicroStrategy manuals provide:
  - Introductory information and concepts
  - Examples and images
  - Checklists and high-level procedures to get started

  The steps to access the manuals are described in *Accessing manuals and other documentation sources, page 102*. Most of these manuals are also available printed in a bound, soft cover format. To purchase printed manuals, contact your MicroStrategy account executive or email documentationfeedback@microstrategy.com.

- **Help**: In general, MicroStrategy help provides:
  - Detailed steps to perform procedures
  - Descriptions of each option on every software screen

  Due to translation time, manuals in languages other than English may contain information that is one or more releases behind. You can see the version number on the title page of each manual. For the most up-to-date translations, refer to the MicroStrategy Knowledge Base.

MicroStrategy overview and evaluation

- **Introduction to MicroStrategy: Evaluation Guide**

  Instructions for installing, configuring, and using the MicroStrategy Evaluation Edition of the software. This guide also includes a detailed, step-by-step evaluation process of MicroStrategy features, where you perform reporting with the MicroStrategy Tutorial project and its sample business data.


  Overview of the installation and evaluation process, and additional resources.
• **Evaluate MicroStrategy for Linux Guide: In a Windows or Linux Environment with the MicroStrategy Evaluation Edition Virtual Appliance**

Evaluate MicroStrategy for Linux, in a Microsoft Windows or Linux environment, with the MicroStrategy Evaluation Edition Virtual Appliance. This guide provides all details to download, activate, and evaluate MicroStrategy software running in a Linux environment.

• **MicroStrategy Reporting Suite: Quick Start Guide**

Evaluate MicroStrategy as a departmental solution. Provides detailed information to download, install, configure, and use the MicroStrategy Reporting Suite.

• **MicroStrategy Mobile Suite: Quick Start Guide**

Evaluate MicroStrategy Mobile as a departmental solution. Provides detailed information to download, install, configure, and use the MicroStrategy Mobile Suite.

---

### Manuals for query, reporting, and analysis

• **MicroStrategy Installation and Configuration Guide**

Information to install and configure MicroStrategy products on Windows, UNIX, Linux, and HP platforms, as well as basic maintenance guidelines.

• **MicroStrategy Upgrade Guide**

Instructions to upgrade existing MicroStrategy products.

• **MicroStrategy Project Design Guide**

Information to create and modify MicroStrategy projects, and understand facts, attributes, hierarchies, transformations, advanced schemas, and project optimization.

• **MicroStrategy Basic Reporting Guide**

Instructions to get started with MicroStrategy Desktop and MicroStrategy Web, and how to analyze data in a report. Includes the basics for creating reports, metrics, filters, and prompts.
• **MicroStrategy Advanced Reporting Guide: Enhancing Your Business Intelligence Application**

Instructions for advanced topics in the MicroStrategy system, building on information in the Basic Reporting Guide. Topics include reports, Freeform SQL reports, Query Builder reports, filters, metrics, Data Mining Services, custom groups, consolidations, and prompts.


Instructions for a business analyst to execute and analyze a document in MicroStrategy Desktop and MicroStrategy Web, building on basic concepts about projects and reports presented in the *MicroStrategy Basic Reporting Guide*.

• **MicroStrategy Report Services Document Creation Guide: Creating Boardroom Quality Documents**


• **MicroStrategy OLAP Services Guide**

Information on MicroStrategy OLAP Services, which is an extension of MicroStrategy Intelligence Server. OLAP Services features include Intelligent Cubes, derived metrics, derived elements, dynamic aggregation, view filters, and dynamic sourcing.

• **MicroStrategy Office User Guide**

Instructions for using MicroStrategy Office to work with MicroStrategy reports and documents in Microsoft® Excel, PowerPoint, Word, and Outlook, to analyze, format, and distribute business data.

• **MicroStrategy Mobile Analysis Guide: Analyzing Data with MicroStrategy Mobile**

Information and instructions for using MicroStrategy Mobile to view and analyze data, and perform other business tasks with MicroStrategy reports and documents on a mobile device.

• **MicroStrategy Mobile Design and Administration Guide: A Platform for Mobile Intelligence**

Information and instructions to install and configure MicroStrategy Mobile, as well as instructions for a designer working in MicroStrategy Desktop or MicroStrategy Web to create effective reports and documents for use with MicroStrategy Mobile.
• **MicroStrategy System Administration Guide: Tuning, Monitoring, and Troubleshooting your MicroStrategy Business Intelligence System**

  Concepts and high-level steps to implement, deploy, maintain, tune, and troubleshoot a MicroStrategy business intelligence system.

• **MicroStrategy Supplemental Reference for System Administration: VLDB Properties, Internationalization, User Privileges, and other Supplemental Information for Administrators**

  Information and instructions for MicroStrategy administrative tasks such as configuring VLDB properties and defining data and metadata internationalization, and reference material for other administrative tasks.

• **MicroStrategy Functions Reference**

  Function syntax and formula components; instructions to use functions in metrics, filters, attribute forms; examples of functions in business scenarios.

• **MicroStrategy MDX Cube Reporting Guide**

  Information to integrate MicroStrategy with MDX cube sources. You can integrate data from MDX cube sources into your MicroStrategy projects and applications.

---

**Manuals for Analytics Modules**

• **Analytics Modules Installation and Porting Guide**

• **Customer Analysis Module Reference**

• **Sales Force Analysis Module Reference**

• **Financial Reporting Analysis Module Reference**

• **Sales and Distribution Analysis Module Reference**

• **Human Resources Analysis Module Reference**
Manuals for Narrowcast Services products

- *MicroStrategy Narrowcast Server Getting Started Guide*
  Instructions to work with the tutorial to learn Narrowcast Server interfaces and features.

- *MicroStrategy Narrowcast Server Installation and Configuration Guide*
  Information to install and configure Narrowcast Server.

- *MicroStrategy Narrowcast Server Application Designer Guide*
  Fundamentals of designing Narrowcast Server applications.

- *MicroStrategy Narrowcast Server System Administrator Guide*
  Concepts and high-level steps to implement, maintain, tune, and troubleshoot Narrowcast Server.

- *MicroStrategy Narrowcast Server Upgrade Guide*
  Instructions to upgrade an existing Narrowcast Server.

Software Development Kits

- *MicroStrategy Developer Library (MSDL)*
  Information to understand the MicroStrategy SDK, including details about architecture, object models, customization scenarios, code samples, and so on.

- *MicroStrategy Web SDK*
  The Web SDK is available in the MicroStrategy Developer Library, which is sold as part of the MicroStrategy SDK.

- *Narrowcast Server SDK Guide*
  Instructions to customize Narrowcast Server functionality, integrate Narrowcast Server with other systems, and embed Narrowcast Server functionality within other applications. Documents the Narrowcast Server Delivery Engine and Subscription Portal APIs, and the Narrowcast Server SPI.
Documentation for MicroStrategy Portlets

• **Enterprise Portal Integration Help**

  Information to help you implement and deploy MicroStrategy BI within your enterprise portal, including instructions for installing and configuring out-of-the-box MicroStrategy Portlets for several major enterprise portal servers.

  This resource can be accessed using the MicroStrategy Product Manuals page, as described in *Accessing manuals and other documentation sources, page 102.*

Documentation for MicroStrategy GIS Connectors

• **GIS Integration Help**

  Information to help you integrate MicroStrategy with Geospatial Information Systems (GIS), including specific examples for integrating with ESRI mapping services.

  This resource can be accessed using the MicroStrategy Product Manuals page, as described in *Accessing manuals and other documentation sources, page 102.*

Help

Each MicroStrategy product includes an integrated help system to complement the various interfaces of the product as well as the tasks that can be accomplished using the product.

Some of the MicroStrategy help systems require a web browser to be viewed. For supported web browsers, see the MicroStrategy Readme.

MicroStrategy provides several ways to access help:

• **Help button:** Use the Help button or ? (question mark) icon on most software windows to see help for that window.

• **Help menu:** From the Help menu or link at the top of any screen, select MicroStrategy Help to see the table of contents, the Search field, and the index for the help system.
F1 key: Press F1 to see context-sensitive help that describes each option in the software window you are currently viewing.

For MicroStrategy Web, MicroStrategy Web Administrator, and MicroStrategy Mobile Server, pressing the F1 key opens the context-sensitive help for the web browser you are using to access these MicroStrategy interfaces. Use the Help menu or ? (question mark) icon to access help for these MicroStrategy interfaces.

**Accessing manuals and other documentation sources**

The manuals are available from your MicroStrategy disk or the machine where MicroStrategy was installed.

Adobe Acrobat Reader is required to view these manuals. If you do not have Acrobat Reader installed on your computer, you can download it from [http://get.adobe.com/reader/](http://get.adobe.com/reader/).

The best place for all users to begin is with the *MicroStrategy Basic Reporting Guide*.

To access the installed manuals and other documentation sources, see the following procedures:

- *To access installed manuals and other documentation sources on Windows, page 102*
- *To access installed manuals and other documentation sources on UNIX and Linux, page 103*

**To access installed manuals and other documentation sources on Windows**

1. From the Windows **Start** menu, choose **Programs** (or **All Programs**), **MicroStrategy**, then **Product Manuals**. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

2. Click the link for the desired manual or other documentation source.

3. If you click the link for the Narrowcast Services SDK Guide, a File Download dialog box opens. This documentation resource must be
downloaded. Select **Open this file from its current location**, and click **OK**.

If bookmarks are not visible on the left side of an Acrobat (PDF) manual, from the **View** menu click **Bookmarks and Page**. This step varies slightly depending on your version of Adobe Acrobat Reader.

---

**To access installed manuals and other documentation sources on UNIX and Linux**

1. Within your UNIX or Linux machine, navigate to the directory where you installed MicroStrategy. The default location is `/opt/MicroStrategy`, or `$HOME/MicroStrategy/install` if you do not have write access to `/opt/MicroStrategy`.

2. From the MicroStrategy installation directory, open the Documentation folder.

3. Open the `Product_Manuals.htm` file in a web browser. A page opens in your browser showing a list of available manuals in PDF format and other documentation sources.

4. Click the link for the desired manual or other documentation source.

5. If you click the link for the Narrowcast Services SDK Guide, a File Download dialog box opens. This documentation resource must be downloaded. Select **Open this file from its current location**, and click **OK**.

If bookmarks are not visible on the left side of an Acrobat (PDF) manual, from the **View** menu click **Bookmarks and Page**. This step varies slightly depending on your version of Adobe Acrobat Reader.

---

**Accessing additional documentation resources prior to installation**

Once you have extracted the installation files, you can review additional documentation resources prior to installing MicroStrategy. The steps below show you how to access these additional documentation resources.

**Prerequisites**

- You have downloaded and extracted the installation files.
To access additional documentation resources

1. Navigate to the folder in which you extracted the installation files.

2. Open the Documentation folder.

3. Open the `Product_Manuals.htm` file in a web browser. A page opens in your web browser showing a list of available manuals in PDF format and other documentation sources.

4. Click the link for the desired manual or other documentation source. The following documentation sources provide important information to support the installation of MicroStrategy:

   - **MicroStrategy Readme**: The MicroStrategy Readme provides requirements to support the installation of MicroStrategy products.

   - **Installation and Configuration Guide**: The *Installation and Configuration Guide* provides additional information to help support the installation and initial configuration of MicroStrategy products. Refer to this guide if you encounter any installation issues related to your specific environment.

---

**Documentation standards**

MicroStrategy online help and PDF manuals (available both online and in printed format) use standards to help you identify certain types of content. The following table lists these standards.

These standards may differ depending on the language of this manual; some languages have rules that supersede the table below.

<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
</table>
| **bold** | - Button names, check boxes, options, lists, and menus that are the focus of actions or part of a list of such GUI elements and their definitions  
- Text to be entered by the user  
Example: Click **Select Warehouse**.  
Example: Type `cmdmgr -f scriptfile.scp` and press **Enter**. |
<table>
<thead>
<tr>
<th>Type</th>
<th>Indicates</th>
</tr>
</thead>
<tbody>
<tr>
<td>italic</td>
<td>• New terms defined within the text and in the glossary</td>
</tr>
<tr>
<td></td>
<td>• Names of other product manuals</td>
</tr>
<tr>
<td></td>
<td>• When part of a command syntax, indicates variable information to be replaced by the user</td>
</tr>
<tr>
<td></td>
<td>Example: The <em>aggregation level</em> is the level of calculation for the metric.</td>
</tr>
<tr>
<td></td>
<td>Example: Type <em>copy c:\filename d:\foldername\filename</em></td>
</tr>
<tr>
<td>Courier font</td>
<td>• Calculations</td>
</tr>
<tr>
<td></td>
<td>• Code samples</td>
</tr>
<tr>
<td></td>
<td>• Registry keys</td>
</tr>
<tr>
<td></td>
<td>• Path and file names</td>
</tr>
<tr>
<td></td>
<td>• URLs</td>
</tr>
<tr>
<td></td>
<td>• Messages displayed in the screen</td>
</tr>
<tr>
<td></td>
<td>Example: <em>Sum(revenue)/number of months.</em></td>
</tr>
<tr>
<td>+</td>
<td>A keyboard command that calls for the use of more than one key (for example, SHIFT+F1)</td>
</tr>
<tr>
<td>📜</td>
<td>A note icon indicates helpful information for specific situations.</td>
</tr>
<tr>
<td>🚨</td>
<td>A warning icon alerts you to important information such as potential security risks; these should be read before continuing.</td>
</tr>
</tbody>
</table>

**Additional formats**

This book is also available as an electronic publication in the Apple iBookstore, and can be read on an iPhone or iPad with the iBooks app installed. To download this book, search for the book’s title in the iBookstore search bar, or scan the QR code below using your device's camera.